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TI 参参考考设设计计

支支持持低低于于 1GHz 无无线线连连接接且且可可使使纽纽扣扣电电池池使使用用寿寿命命长长达达 10 年年的的
低低功功耗耗 PIR 运运动动检检测测器器

TI 参参考考设设计计

此 TI 设计使用德州仪器 (TI) 的纳米级功率运算放大

器、比较器和 SimpleLink™ 超低功耗低于 1GHz 无线

微控制器 (MCU) 平台，展示了一款超低功耗运动检测

器，极大地延长了电池寿命且无需接线。

设设计计资资源源

TIDA-00489 设计文件夹

LPV802 产品文件夹

TLV3691 产品文件夹

CC1310 产品文件夹

请咨询我们的 E2E 专家

设设计计 特特性性

• 将毫微功耗模拟器件用于超低功耗设计，从而使单

个 CR2032 纽扣电池实现 10 年的使用寿命

• 待机电流低至 1.65μA（PIR 传感器在待机模式下仍

保持工作状态）

• 由于处理器工作电流和无线电发射电流较低，因此

可实现超低的工作电流

（1.12mA，持续 104.1ms）

• 低于 1GHz 的中断驱动型移动无线通信，可节省更

多功耗

• 移动灵敏度高达 30英尺

典典型型 应应用用

• 楼宇自动化

• 入侵检测

• 占位检测

• 运动检测

• 室内监视器

• 电池供电系统

该 TI 参考设计末尾的重要声明表述了授权使用、知识产权问题和其他重要的免责声明和信息。

http://www-s.ti.com/sc/techlit/TIDUAU1.pdf
http://www.ti.com.cn/tool/cn/TIDA-00489
http://www.ti.com.cn/product/cn/LPV802
http://www.ti.com.cn/product/cn/TLV3691
http://www.ti.com.cn/product/cn/CC1310
http://e2e.ti.com
http://e2e.ti.com/support/applications/ti_designs/
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1 Key System Specifications

表表 1. Key System Specifications

PARAMETER SPECIFICATIONS DETAILS
Input power source CR2032 Lithium-ion coin cell battery (3.0-V nominal voltage) 2.4 节

Sensor type PIR (Pyroelectric or Passive InfraRed) 2.5 节

Average active-state current consumption 1.12 mA 8.1 节

Active-state duration 104.1 ms 8.1 节

Average standby-state current
consumption 2.3 µA 8.1 节

Standby-state duration 1 minute of no motion detected 4.4 节

Sleep-state current consumption 1.65 µA 8.1 节

Movements per hour assumed for lifetime
calculation ≥10 per hour average over the battery lifetime (worst case) 8.2 节

Estimated battery life > 10 years 8.2 节

Motion sensing range 30 feet nominal 节 8.3.1
Radio transmission range > 200 meters 节 8.3.2
Operating temperature –30°C to 60°C (limited by CR2032 coin cell operating range) 2.4 节

Operating humidity 20 to 70% 节 7.3.1
Vibration 节 8.3.4
RF immunity 30 V/m from 10 kHz to 1 GHz 节 8.3.3
Working environment Indoor and outdoor 2.4 节

Form factor 35×75-mm rectangular PCB 9.5 节

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/TIDUAU1.pdf
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2 System Description

Many industrial and building automation systems use motion detectors to control different functions based
on human presence, such as lighting, for achieving higher efficiency of those functions by turning them off
when not needed. Additionally, these systems require increasing numbers of wireless sensor nodes to
reduce the installation costs and the make the systems more flexible for future expansion by eliminating
wiring. However, one of the major limitations for a large wireless network is power. Because these
systems are battery powered, the maintenance cost associated with periodic battery replacement can
become prohibitive. Depending on the power consumption and battery configuration, typical battery-
powered PIR motion detectors can run anywhere from four to seven years before the batteries need to be
replaced.

Enabled by Texas Instruments' nano-power amplifiers, comparators, and the SimpleLink ultra-low-power
wireless MCU platform, the Low-Power PIR Motion Detector With Sub-1GHz Wireless Connectivity
Enabling 10-Year Coin Cell Battery Life TI Design demonstrates a motion detector circuit solution requiring
no wiring while also fully maximizing the battery life.

At a high level, this TI Design consists of a CR2032 coin cell battery, two nano-power op amps, two nano-
power comparators, an ultra-low-power wireless MCU, and a PIR sensor with analog signal output. The
two op amps form an amplified bandpass filter with a high input impedance, which allows it to be
connected directly to the sensor without loading it. The two comparators form a window comparator, which
is used to compare the amplified sensor output to fixed reference thresholds so that motion can be
distinguished from noise. The two outputs of the window comparator then serve as interrupts to the
wireless MCU so that the MCU can operate in its lowest power sleep mode during times where there is no
motion being detected and only wakes up to send messages back to a remote host when motion has
been detected. Due to the nano-amp operation of the analog signal chain components, this TI Design
achieves a 10-year battery life from a single CR2032 coin cell battery.

This design guide addresses component selection, design theory, and the testing results of this TI Design
system. The scope of this design guide gives system designers a head-start in integrating TI’s nano-power
analog components, and the SimpleLink ultra-low-power wireless MCU platform.

The following sub-sections describe the various blocks within the TI Design system and what
characteristics are most critical to best implement the corresponding function.

2.1 Operational Amplifiers

In this TI Design, it is necessary to amplify and filter the signal at the output of the PIR sensor so that the
signal amplitudes going into following stages in the signal chain are large enough to provide useful
information.

Typical signal levels at the output of a PIR sensor are in the micro-volt range for motion of distant objects
which exemplifies the need for amplification. The filtering function is necessary to primarily limit the noise
bandwidth of the system before reaching the input to the window comparator. Secondarily, the filtering
function also serves to set limits for the minimum and maximum speed at which the system will detect
movement.

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/TIDUAU1.pdf
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For an extremely long battery life, this TI Design uses the LPV802 because of its low current consumption
of 320 nA (typical) per amplifier. Other considerations that make the LPV802 ideal for this TI Design are
its low input voltage offset and low input bias current, which allows use of high value resistors, and rail-to-
rail operation on both input and output. Additionally, the LPV802 integrates EMI protection to reduce
sensitivity to unwanted RF signals, which is useful for low-power designs because of their high impedance
nodes.

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/TIDUAU1.pdf
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2.2 Comparators

In this TI Design, it is necessary to convert the amplified and filtered version of the sensor output into
digital signals, which can be used as inputs to the MCU. To accomplish this, a window comparator circuit
is used.

The low current consumption of only 75 nA (typical) per comparator makes the TLV3691 in this TI Design
ideal. Other considerations for the comparator in this reference design include its low input voltage offset
and low input bias current. Additionally, the TLV3691 features a rail-to-rail input stage with an input
common mode range, which exceeds the supply rails by 100 mV, thereby preventing output phase
inversion when the voltage at the input pins exceed the supply. This translates not only into robustness to
supply noise, but also maximizes the flexibility in adjusting the window comparator thresholds in this
design.

2.3 Ultra-Low-Power Wireless MCU

In this TI Design, transmitting the sensor information to some central location for processing is necessary.
However, because power consumption is always a concern in battery-based applications, the radio and
processor must be low power. Also, the wireless protocol required for the end-equipment system is an
important consideration for the selection of the radio device.

With TI’s SimpleLink ultra-low-power wireless MCU platform, low power with a combined radio and MCU
enables an extremely long battery life for sensor end-nodes. Furthermore, the CC1310 is a multi-standard
device with software stack support for wM-Bus and IEEE 802.15.4g. In this TI Design, a generic sub-1GHz
network protocol is the protocol of choice, but the hardware as built can work with other protocols as well.

2.4 Coin Cell Battery

The power source for this TI Design is a CR2032 lithium-ion coin cell. The selection of the CR2032 coin
cell battery as the power source was due to the ubiquity of that battery type, particularly in small form
factor systems such as a sensor end-node.

The voltage characteristics of a lithium-ion CR2032 coin cell battery are also ideal. The output voltage
remains relatively flat throughout the discharge life until the cell is nearly depleted. When the cell is
depleted, the output voltage drops off relatively quickly.

The temperature characteristics of lithium-ion batteries are also superior to that of alkaline cells,
particularly at lower temperatures. This superiority is due to lithium-ion cells having a non-aqueous
electrolyte that performs better than aqueous electrolytes commonly found in alkaline batteries. However,
the CR2032 coin cell battery is still the limiting component in terms of the operating temperature range; all
of the integrated circuits and other electrical components are specified to operate at a wider temperature
range than the battery. Therefore, the specified operating temperature range of the TI Design system is
−30°C to 60°C. Given an appropriate weather-proof enclosure, this TI Design system is suited for both
indoor and outdoor use.

Immediately following the battery is a low RDS_ON P-channel MOSFET and a bulk capacitor. The P-channel
MOSFET prevents damage to the hardware if the coin cell battery is inserted backwards while minimizing
the forward voltage drop in normal operation. The bulk capacitor is sized to prevent too much voltage
droop, particularly during the transitions into the MCU on-state for radio transmissions.

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/TIDUAU1.pdf
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2.5 PIR Sensor

The sensor chosen for the TI Design is the Murata IRS-B210ST01 PIR sensor. The choice of this sensor
was due to the fact that it is in a surface mount package and provides an analog output so that the low-
power circuit in this TI Design could be demonstrated in an area efficient footprint.

While the test results collected for this TI Design are focused on a particular PIR sensor part number, it is
expected that similar results can be obtained with any similarly specified PIR sensor that is available when
the techniques and circuit designs demonstrated in this TI Design are applied.

Lastly, for any PIR sensor, it is necessary to use a lens in front of the sensor to extend the detection range
by focusing the infrared energy onto the sensor elements. Using a Fresnel lens, the infrared image for the
viewing area is spread across all of the sensor elements. The lens shape and size, therefore, determines
the overall detection angle and viewing area. For this TI Design, the Murata IML-0669 lens is used so that
a maximum field of view and detection range could be demonstrated. Ultimately, the choice of lens will be
determined by the field of view angle and detection range required by the application.

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/TIDUAU1.pdf
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3 Block Diagram

图图 1. Wireless PIR System Block Diagram

3.1 Highlighted Products

The Low-Power PIR Motion Detector reference design features the following devices:

• LPV802 (节 3.1.1): NanoPower, CMOS input, rail-to-rail IO operational amplifier

• TLV3691 (节 3.1.2): NanoPower, CMOS input, rail-to-rail input comparator

• CC1310 (节 3.1.3): SimpleLink multi-standard sub-1GHz ultra-low-power wireless MCU

For more information on each of these devices, see their respective product folders at www.ti.com.

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/TIDUAU1.pdf
http://www.ti.com
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3.1.1 LPV802

Features:

• For VS = 3.3 V, typical unless otherwise noted

– Supply current at 320 nA

– Operating voltage range: 1.6 to 5.5 V

– Low TCVOS 1 µV/°C

– VOS 3.5 mV (max)

– Input bias current: 100 fA

– PSRR: 115 dB

– CMRR: 98 dB

– Open-loop gain: 120 dB

– Gain bandwidth product: 8 kHz

– Slew rate: 2 V/ms

– Input voltage noise at
f = 100 Hz 340 nV/√Hz

– Temperature range: −40°C to 125°C

Applications:

• Gas Detectors (CO and O2)

• PIR Motion Detectors

• Ionization Smoke Detectors

• Thermostats

• IoT Remote Sensors

• Active RFID readers and Tags

• Portable Medical Equipment

• Sensor network powered by energy scavenging

图图 2. LPV802 Functional Block Diagram

The LPV802 is a dual nano-power amplifier designed for ultra-long life battery applications. The operating
voltage range of 1.6 V to 5.5 V coupled with typically 320 nA of supply current per channel make it well
suited for remote sensor applications. The LPV802 has a carefully designed CMOS input stage that
outperforms competitors with typically 100 fA IBIAS currents and CMRR of 98 dB. This low input current
significantly reduces IBIAS and IOS errors introduced in megohm resistance, high impedance photodiode,
and charge sense situations. The LPV802 is a member of the PowerWise™ family and has an exceptional
power-to-performance ratio.

EMI protection was designed into the device to reduce sensitivity to unwanted RF signals.

The LPV802 is offered in the 8-pin VSSOP 3.00 mm × 3.00 mm package.

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/TIDUAU1.pdf
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3.1.2 TLV3691

Features:

• Low quiescent current: 75 nA

• Wide supply:

– 0.9 to 6.5 V

– ±0.45 to ±3.25 V

• Micro packages: DFN-6 (1 × 1 mm),
5-pin SC70

• Input common-mode range extends 100 mV
beyond both rails

• Response time: 24 µs

• Low input offset voltage: ±3 mV

• Push-pull output

• Industrial temperature range:
–40°C to 125°C

Applications:

• Overvoltage and undervoltage detection

• Window comparators

• Overcurrent detection

• Zero-crossing detection

• System monitoring:

– Smart phones

– Tablets

– Industrial sensors

– Portable medical

The TLV3691 offers a wide supply range, low quiescent current 150 nA (maximum), and rail-to-rail inputs.
All of these features come in industry-standard and extremely small packages, making this device an
excellent choice for low-voltage and low-power applications for portable electronics and industrial systems.

Available as a single channel, the low-power, wide supply, and temperature range makes this device
flexible enough to handle almost any application from consumer to industrial. The TLV3691 is available in
SC70-5 and 1×1-mm DFN-6 packages. This device is specified for operation across the expanded
industrial temperature range of –40°C to 125°C.

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/TIDUAU1.pdf
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3.1.3 CC1310

Features:

• MCU:

– Powerful ARM® Cortex®-M3

– EEMBC CoreMark® score: 142

– EEMBC ULPBench™ score: 158

– Up to 48-MHz clock speed

– 128KB of in-system programmable Flash

– 8KB of SRAM for cache (or as general-purpose RAM)

– 20 KB of ultra-low leakage SRAM

– 2-pin cJTAG and JTAG debugging

– Supports over-the-air (OTA) upgrade

• Ultra-low-power sensor controller:

– Can run autonomous from the rest of the system

– 16-bit architecture

– 2KB of ultra-low leakage SRAM for code and data

• Efficient code-size architecture, placing TI-RTOS, drivers, Bluetooth® Low Energy Controller, IEEE
802.15.4 MAC, and Bootloader in ROM

• RoHS-compliant package:

– 7×7-mm RGZ VQFN48 (30 GPIOs)

– 5×5-mm RHB VQFN48 (15 GPIOs)

– 4×4-mm RSM VQFN48 (10 GPIOs)

• Peripherals:

– All digital peripheral pins can be routed to any GPIO

– Four general-purpose timer modules
(Eight 16-bit or four 32-bit timers, PWM each)

– 12-bit ADC, 200 ksps, 8-channel analog MUX

– Continuous time comparator

– Ultra-low-power clocked comparator

– Programmable current source

– UART

– 2× SSI (SPI, MICROWIRE, TI)

– I2C

– I2S

– Real-time clock (RTC)

– AES-128 security module

– True random number generator (TRNG)

– Support for eight capacitive sensing buttons

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/TIDUAU1.pdf
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– Integrated temperature sensor

• External system:

– On-chip internal DC-DC converter

– Very few external components

– Seamless integration with the SimpleLink CC1190 range extender

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/TIDUAU1.pdf
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• Low power:

– Wide supply voltage range: 1.8 to 3.8 V

– Active-Mode RX: 5.5 mA

– Active-Mode TX at 10 dBm: 12.9 mA

– Active-mode MCU 48 MHz running CoreMark: 2.5 mA (51 µA/MHz)

– Active-mode MCU: 48.5 CoreMark/mA

– Active-mode sensor controller at 24 MHz:
0.4 mA + 8.2 µA/MHz

– Sensor controller, one wake up every second performing one 12-bit ADC sampling: 0.85 µA

– Standby: 0.6 µA (RTC running and RAM and CPU retention)

– Shutdown: 185 nA (wakeup on external events)

• RF section:

– 2.4-GHz RF transceiver compatible with Bluetooth Low Energy (BLE) 4.1 specification and IEEE
802.15.4 PHY and MAC

– Excellent receiver sensitivity –124 dBm using long-range mode, –110 dBm at 50 kbps, –89 dBm at
BLE

– Excellent selectivity: 52 dB

– Excellent blocking performance: 90 dB

– Programmable output power up to 14 dBm

– Single-ended or differential RF interface

– Suitable for systems targeting compliance with worldwide radio frequency regulations:

• ETSI EN 300 220, EN 303 131,
EN 303 204 (Europe)

• EN 300 440 Class 2 (Europe)

• FCC CFR47 Part 15 (US)

• ARIB STD-T108 (Japan)

– Wireless M-Bus and IEEE 802.15.4g PHY

• Tools and development environment:

– Full-feature and low-cost development kits

– Multiple Reference Designs for Different RF Configurations

– Packet sniffer PC software

– Sensor Controller Studio

– SmartRF™ Studio

– SmartRF Flash Programmer 2

– IAR Embedded Workbench® for ARM

– Code Composer Studio™

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/TIDUAU1.pdf
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图图 3. CC1310 Functional Block Diagram

This device is a member of the CC26xx and CC13xx family of cost-effective, ultra-low-power, 2.4-GHz and
sub-1GHz RF devices. Very low active RF, MCU current, and low-power mode current consumption
provide excellent battery lifetime and allow operation on small coin-cell batteries and in energy-harvesting
applications.

The CC1310 is the first part in a Sub-1GHz family of cost-effective, ultra-low-power wireless MCUs. The
CC1310 device combines a flexible, very low-power RF transceiver with a powerful 48-MHz Cortex-M3
MCU in a platform supporting multiple physical layers and RF standards. A dedicated radio controller
(Cortex-M0) handles low-level RF protocol commands that are stored in ROM or RAM, thus ensuring ultra-
low power and flexibility. The low-power consumption of the CC1310 does not come at the expense of RF
performance; the CC1310 has excellent sensitivity and robustness (selectivity and blocking) performance.

The CC1310 is a highly integrated, true single-chip solution incorporating a complete RF system and an
on-chip DC-DC converter.

Sensors can be handled in a very low-power manner by a dedicated autonomous ultra-low-power MCU
that can be configured to handle analog and digital sensors; thus the main MCU (Cortex-M3) is able to
maximize sleep time.

http://www.ti.com.cn
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The CC1310 power and clock management and radio systems require specific configuration and handling
by software to operate correctly. This has been implemented in the TI RTOS, and it is therefore
recommended that this software framework is used for all application development on the device. The
complete TI-RTOS and device drivers are offered in source code free of charge.

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/TIDUAU1.pdf
http://www.ti.com/tool/ti-rtos
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4 System Design Theory

The Low-Power PIR Motion Detector With Sub-1GHz Wireless Connectivity Reference Design senses
motion by detecting differences in infrared (IR) energy in the field of view of the sensor. Because the
sensor output is a very small signal, amplification and filtering are necessary to boost the signal and at the
same time filter noise so that a representation of the sensor output at a reasonable signal level is obtained
while also minimizing false trigger events. The scaled analog output is then converted to digital signals by
a window comparator function whose outputs can be used as interrupts to the wireless MCU to save
power by only waking up the MCU when it is needed. The following sections discuss the details of the
design for these different circuit sections that make up the design’s overall sub-system.

4.1 PIR Sensor

To better understand the circuit, the user must understand how the PIR motion sensor operates. The PIR
motion sensor consists of two or more elements that output a voltage proportional to the amount of
incident infrared radiation. Each pair of pyroelectric elements are connected in series such that if the
voltage generated by each element is equal, as in the case of IR due to ambient room temperature or no
motion, then the overall voltage of the sensor elements is 0 V. 图 4 shows an illustration of the PIR motion
sensor construction.

图图 4. PIR Motion Sensor Illustration

The lower part of 图 4 shows the output voltage signal resulting from movement of a body with a different
temperature than the ambient parallel to the surface of the sensor and through the field of view of both
sensor elements. The amplitude of this signal is proportional to the speed and distance of the object
relative to the sensor and is in a range of low millivolts peak to peak to a few hundred microvolts peak to
peak or less. A JFET transistor is used as a voltage buffer and provides a DC offset at the sensor output.

Because of the small physical size of the sensor elements, a Fresnel lens is typically placed in front of the
PIR sensor to extend the range as well as expanding the field of view by multiplying and focusing the IR
energy onto the small sensor elements. In this manner, the shape and size of the lens determine the
overall detection angle and viewing area. The style of lens is typically chosen based on the application
and choice of sensor placement in the environment. Based on this information, for best results, the sensor
should be placed so that movement is across the sensor instead of straight into the sensor and away from
sources of high or variable heat such as AC vents and lamps.
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Also note that on initial power up of the sensor, it takes up to 30 s or more for the sensor output to
stabilize. During this "warm up" time, the sensor elements are adjusting themselves to the ambient
background conditions. This is a key realization in designing this subsystem for maximum battery life in
that the sensor itself must be continuously powered for proper operation, which means power cycling
techniques applied to either the sensor or the analog signal path itself cannot be applied for proper
operation and reliable detection of motion.

4.2 Analog Signal Path

The analog signal conditioning section is shown in the schematic in 图 5. The first two stages in 图 5
implement the amplified filter function whereas stage 3 implements the window comparator design.
Components R10 and C5 serve as a low pass filter to stabilize the supply voltage at the input to the
sensor and are discussed further in 4.3 节.

图图 5. PIR Motion Sensor Analog Signal Path Schematic

Resistor R5 sets the bias current in the JFET output transistor of the PIR motion sensor. To save power,
R5 is larger than recommended and essentially current starves the sensor. This comes at the expense of
decreased sensitivity and higher output noise at the sensor output, which is a fair tradeoff for increased
battery lifetime. Some of the loss in sensitivity at the sensor output can be compensated by a gain
increase in the filter stages. Due to the higher gain in the filter stages and higher output noise from the
sensor, carefully optimize the placement of the high frequency filter pole and the window comparator
thresholds to avoid false detection.

4.2.1 Amplified Filter Design

Composed of stages 1 and 2 in 图 5, the filter section implements a fourth order bandpass filter using
simple poles. Each stage implements identical second order bandpass filter characteristics. The chosen
cutoff frequencies for the bandpass filter are set to 0.7 and 10.6 Hz. The passband gain of each stage is
220 for an overall signal gain of ~90 dB and was chosen to maximize the motion sensitivity range for the
sensor bias point being used. The data collected for motion sensitivity range at different sensor bias and
gain settings is shown in 节 8.3.1.
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Generally, the filter bandwidth should be wide enough to detect a person walking or running by the sensor.
At the same time, the filter bandwidth should be narrow to limit the peak-to-peak noise at the output of the
filter. In most cases, a bandwidth between 0.3 to 2 Hz is acceptable for this application; however, the use
of simple poles means the filter Q is low, which leads to a large filter transition region. With the poles
placed this close, the overall passband gain is reduced, which reduces sensitivity and increases the noise
floor.

The low frequency cutoff is critical because it has a major effect on the system noise floor by limiting the
overall impact of 1/f noise from the analog front end as well as setting the minimum speed of motion that
the system can detect. The practical lower limit on the low frequency cutoff is due to capacitor sizing at
0.1 Hz. Due to the low bias current being used in the sensor for this design, the low frequency noise will
be worse than a normal higher current design, which means the low frequency cutoff should be higher
than 0.3 Hz. Given a practical range of the low frequency cutoff to be between 0.3 to 1 Hz, this design
used a low frequency cutoff in the middle of this range.

The high frequency cutoff is mostly for reducing broadband noise. The range for its placement will be a
decade higher than the low frequency cutoff up to the bandwidth limit set by the open loop bandwidth of
the op amp being used. In this case, the LPV802 has a unity gain bandwidth (UGBW) of 8 kHz, which
means for a maximum stage gain of 220, the bandwidth is limited to 36 Hz. Allowing for component
tolerances and variation in the UGBW of the LPV802, a practical range for the high frequency cutoff is
between 7 and 14 Hz. Again, the choice was made to use a high frequency cutoff in the middle of this
range.

The first stage of the filter is arranged as a non-inverting gain stage. This provides a high impedance load
to the sensor so its bias point remains fixed. Because this stage has an effective DC gain of one due to
C2, the sensor output bias voltage provides the DC bias for the first filter stage. Feedback diodes, D1 and
D2 provide clamping so that the op amps in both filter stages stay out of saturation for motion events
which are close to the sensor. 公式 1 to 公式 3 show the gain and cutoff frequencies for this stage:

(1)

(2)

(3)

Since the second stage is AC coupled to the first stage, it is arranged as an inverting gain stage. This
allows the DC bias to be set to VCC/2 easily by connecting the center point of the divider string in the
window comparator to the non-inverting input of the op amp in this filter stage. Because the peak-to-peak
noise is present at the output of this stage, R3 is made as large as possible to minimize the dynamic
current of the system. 公式 4 to 公式 6 show the gain and cutoff frequencies for this stage:

(4)

(5)

(6)

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/TIDUAU1.pdf


REF _Low CC CC

R9
V V 0.25 V

R6 R7 R8 R9
= = ´

+ + +

REF _High CC CC

R7 R8 R9
V V 0.75 V

R6 R7 R8 R9

+ +
= = ´

+ + +

System Design Theory www.ti.com.cn

18 ZHCU133B–October 2015–Revised October 2016

TIDUAU1 — http://www-s.ti.com/sc/techlit/TIDUAU1
版权 © 2015–2016, Texas Instruments Incorporated

支持低于 1GHz 无线连接且可使纽扣电池使用寿命长达 10 年的低功耗 PIR 运
动检测器

The total circuit gain (not including any gain reduction due to pole placement), is given by
G1 × G2 = 221.26 × 220.26 = 48810 = 93.77 dB. 图 6 and 图 7 show simulation results for these two filter
stages.

图图 6. Amplified Filter Simulation Results (Ideal) 图图 7. Amplified Filter Simulation Results (Nonideal)

The responses shown in 图 6 and 图 7 illustrate the effect of finite unity gain bandwidth for the amplifiers
in the circuit. Note that not only is the high frequency response altered, but also the attenuation at the high
frequency cutoff is increased and the peak gain frequency is shifted slightly.

4.2.2 Window Comparator Design

The window comparator circuit shown in stage 3 of 图 5 converts the analog output of the filter to digital
signals, which are used as interrupts to the MCU to tell it when motion has been detected. Composed of
resistors R6 through R9, the resistor divider sets up the thresholds that determine a valid motion detection
from the sensor. To save power, this resistor divider also provides the bias voltage for the second stage of
the filter. Capacitors C6, C7, and C8 are necessary to stabilize the threshold voltages to prevent chatter at
the output of the comparators. These capacitors do not need to be a large value due to the large resistors
being used in the resistor divider, but they should be low ESR and low leakage, with ceramic being
preferred. The comparator chosen for this reference design is the TLV3691 due to its ultra-low supply
current requirements. The TLV3691 comparator also has rail-to-rail input capability with an input common
mode range that exceeds the supply rails by 100 mV. This is not required for this design, but it does allow
the ability to maximize the adjustment range of the window comparator thresholds. The comparator
outputs will be low when there is no motion detected. Typically, motion across the sensor will generate a
high pulse on one comparator output followed by a high pulse on the other comparator, which
corresponds to the amplification of the S-curve waveform shown in the lower part of 图 4. Which
comparator triggers first will depend on the direction of the motion being detected.

公式 7 and 公式 8 are used to adjust the window comparator thresholds:

(7)

(8)

There is also a constraint that R6 + R7 = R8 + R9 so that the VCC/2 bias level is maintained at the center
tap of the divider for use as the bias for the second stage of the filter.
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The thresholds chosen for this design are a balance between sensitivity and noise immunity. Widening of
the window improves noise immunity but reduces sensitivity. Making the window too small can lead to
false triggers due to the peak-to-peak noise seen at the input to the window comparator.

4.3 Power Supply Design

Because of the increasing battery impedance over the life of the battery supply and the low power supply
rejection of the PIR sensor, it is important to design the power supply network to prevent current spikes
generated by the MCU from causing false triggers through the analog signal path. While the algorithm
implemented in firmware helps to filter such problems, this unwanted power supply feedback loop can
become an issue. Ideally, the sensor supply would be regulated to break this loop; however, in this design
the extra quiescent current of a regulator would reduce battery life, so other methods were explored.

图 8 shows a simplified schematic of the power supply network. The PMOS transistor is used in place of
the traditional Schottky diode for reversed battery protection. Because the peak currents are in the
30-mA range when the radio transmits, using a low RDS_ON PMOS provides a much lower voltage drop
compared to a Schottky diode, which helps to maximize battery life by allowing the battery to decay to a
lower voltage before the circuit is no longer able to function (for more on this technique, see SLVA139).

图图 8. PIR Motion Sensor Simplified Power Supply Network Schematic

Capacitor C1 supplies the circuit during periods of high and fast peak current demand, which helps to
maximize the battery capacity and minimize voltage droop on the power supply rail, especially as the
battery approaches its end of life and its internal impedance increases (represented by Rint in 图 8). The
calculation for C1 is provided in 公式 9. For more details on this calculation and the effects of high current
peaks on battery life and capacity, see White Paper SWRA349.

(9)

where

•

•

VMAX is the voltage across the capacitor at the start of the current pulse at the end of the battery’s life, and
VMIN is the circuit operating minimum, which is the sensor minimum plus the voltage drop across R10 due
to the sensor bias current (2 V + 0.6 μA × 619 kΩ ~ 2.4 V). VMAX is taken to be 2.698 V assuming an
unloaded end of life battery voltage of 2.7 V (VP). Based on the measured current profile during a radio
transmission, shown in 图 22 and 图 23:

(10)

For C1:
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(11)

This design uses C1 = 100 μF and additional decades of capacitors in parallel for improved impedance at
higher frequencies. The time required to recharge the composite C1 capacitor after the high current event
is given in 公式 12 and is sufficiently low compared to the active and standby states of the device where
current consumption is in the low microamp range.

(12)

With the value of C1 determined, R10 and C5 can be sized to prevent false triggers from occurring during
high current events on the power supply. With R10 chosen based on the acceptable amount of voltage
drop due to the sensor bias, C5 was determined experimentally. If desired, R10 can be reduced in value
to be able to operate at slightly lower voltage; however, the time constant for R10 and C5 shown in 图 8
needs to be maintained. This means C5 becomes larger and would require a different dielectric, which in
all likelihood would be more leaky or more costly and negate some of the advantage to reducing R10.
Similar to what was done for C1, C5 has additional decades of capacitors in parallel to maintain a low
impedance at higher frequencies.
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4.4 Firmware Control

图图 9. Wireless PIR Firmware Flowchart

The flowchart shown in 图 9 describes the CC1310 operation in this TI Design. The CC1310 first starts by
checking the source of wake up. If the device is woken up by reset, the system is powered on for the first
time. The CC1310 will wait in standby mode for two minutes to allow the PIR sensor and analog signal
chain to power on and allow the operating point to settle. After two minutes, the firmware will look at the
outputs of the window comparator. By default, the output of both comparators should be low. If either
comparator output is high, the CC1310 will send an ERROR message and will wait an additional amount
of time for the sensor to settle. Once the PIR sensor and analog signal chain are functioning correctly, the
CC1310 will enter shutdown mode.

The CC1310 will stay in shutdown mode until the PIR sensor signals the MCU that motion is detected by
means of the window comparator outputs serving as interrupts. When the CC1310 is woken up by the PIR
sensor, it will send an ON packet to notify the host controller that motion has been detected. The CC1310
will wait until the PIR sensor is silent for one minute before sending an OFF packet to the host controller
and returning to shutdown mode.

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/TIDUAU1.pdf


TP7, Window comparator
Low output

Reset J2, JTAG programming interface J3, User mode
Enable

Sub-1GHz
antenna

J4, Spare GPIOs

J1, Main power jumper

TP6, Window comparator
High output

CR2032 Battery holder
(+ side up)

J6, Sensor supply jumper

Getting Started: Hardware www.ti.com.cn

22 ZHCU133B–October 2015–Revised October 2016

TIDUAU1 — http://www-s.ti.com/sc/techlit/TIDUAU1
版权 © 2015–2016, Texas Instruments Incorporated

支持低于 1GHz 无线连接且可使纽扣电池使用寿命长达 10 年的低功耗 PIR 运
动检测器

5 Getting Started: Hardware

图 10 shows the hardware for the Low-Power PIR Motion Detector With Sub-1GHz Wireless Connectivity
Enabling 10-Year Coin Cell Battery Life TI Design. The printed circuit board (PCB) is in a 35×75-mm
rectangular form factor and comes with 0.5-in nylon standoffs to ensure ease of use while performing lab
measurements.

图图 10. Low-Power Wireless PIR Motion Detector Reference Design Hardware Description

All the integrated circuits (CC1310, LPV802, and TLV3691), several test points, and jumpers are located
on the top side of the PCB. The antenna is also located on the top side of the PCB.

The bottom side of the PCB contains the CR2032 coin cell battery holder, jumper J6, and the bottom half
of the antenna.

There are four unused GPIOs that have been brought out from the CC1310 to an unpopulated header to
facilitate future prototyping and debugging.
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5.1 Jumper Configuration

To facilitate measuring critical parameters and debugging in this reference design, there are several
jumpers included. However, to properly operate the design, these jumpers must be installed correctly. The
jumper configuration for normal operation is as follows: J1 = Shorted, J2 = Open, J3 = Open,
J6 = Shorted. The jumper configuration to program the CC1310 is as follows: J1 = Open (power applied to
Pin 2), J2 = Connected through ribbon cable to the SmartRF06 Evaluation Board (EVM), J3 = Open,
J6 = Don’t care.

See 图 10 for a brief description of the intended function of these different jumpers.

5.2 Test Point Description

This design includes several test points to monitor critical signals. The following is a brief description of
these test points:

• TP1, TP2: Ground points for probes or common points for voltage measurements

• TP6, TP7: Window comparator high threshold and low threshold outputs, respectively

• TP8: Filtered battery supply forming input to the DC-DC converter in the CC1310

• TP9: Filtered DC-DC converter output from the CC1310

• TP13: Output of analog filter stage, which is also the input to the window comparator stage

5.3 Miscellaneous

Note that due to the number of sensitive high impedance nodes in this design, probing points aside from
the ones with dedicated test points should be done so with the probe impedance in mind.

An example of this would be the probing of the reference inputs to the window comparator. Because these
reference thresholds are generated from a resistor divider composed of four 15-MΩ resistors, using a
standard oscilloscope probe or voltmeter with a 10-MΩ input impedance will effectively load the circuit
being measured and provide a false measurement.
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6 Getting Started: Firmware

6.1 Loading Firmware

The firmware used on this TI Design was developed using TI’s Code Composer Studio software (version
6.1.0).

The IAR Embedded Workbench for ARM also supports the CC13xx line of SimpleLink products.

Powering the board from 3.0 V is also necessary and is supplied at pin 2 of Jumper J1. Connecting the
external power source at this location bypasses the reversed battery protection.

The TI Design hardware is programmed by connecting the 10-pin mini ribbon cable from J2 to the
SmartRF06 EVM (10-pin ARM Cortex Debug Connector, P410). See 图 11 for a photo of the correct setup
for connecting the TI Designs hardware to the SmartRF06 EVM.

图图 11. Connection of SmartRF06 Evaluation Board and TI Designs Hardware for
Programming and Debugging

6.2 Receiving Data Packets

As this reference guide previously describes, this TI Design is programmed to detect a person’s presence
by using the PIR sensor (see 2.5 节 and 4.1 节). The CC1310 will broadcast three possible action values:

• 0xEE: Error during startup of the sensor

• 0xAA: ON packet when the first motion is detected

• 0xFF: OFF packet one minute after the last motion is detected

To verify the proper operation of the radio transmission, two methods to view the transmitted packet are
described in the following subsections.
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6.2.1 Building Automation Sub-1GHz Sniffer GUI

The first method is a Sniffer GUI firmware running on the SmartRF06 EVM with the CC13xxEM radio. The
Sniffer GUI firmware will process the received packet and display the calculated data on the LCD screen.

As shown in 图 12, the LCD screen will show the six most current received data. If more data is needed
for testing or characterization purposes, 节 6.2.2 describes how to log more data samples for post
analysis.

图图 12. Building Automation Sub-1GHz Sniffer GUI

For more information about the Sniffer GUI, download and install the Building Automation Sub-1GHz
Sniffer GUI software package that is available in 10 节.
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6.2.2 CC1111 USB Dongle and SmartRF Protocol Packet

The second method uses the CC1111 USB dongle, CC1111 USB EVM Kit 868/915 MHz, to "sniff"
packets using the SmartRF™ Protocol Packet Sniffer software. The data is displayed as raw data stream.
This data stream can be post processed and be used for testing and characterization. After installing the
packet sniffer software (v2.18.1 at the time of this writing), the procedure to detect the data transmissions
is as follows:
1. Plug the CC1111 USB dongle into an unused USB port on the computer with the packet sniffer

software installed.
2. Open the packet sniffer software. Choose Generic as the protocol, and click the Start button

(see 图 13).

图图 13. Packet Sniffer Software

http://www.ti.com.cn
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3. Configure the CC1111 correctly to see the packets. Select the Radio Configuration tab. Under the
Register settings sub tab, click on the "Browse…" button. Open the TIDA-00489_CC1111.prs file.
Highlight and double-click on "TIDA-00489_CC1111" to apply the register settings (see 图 14).

图图 14. Packet Sniffer Software, Register Setting

注注: If long data acquisition periods are expected, increase the Cache Buffer size in the packet
sniffer software to prevent possible crashes. Take this action by opening the Settings menu
and clicking "Cache buffer size...".

4. Press the Play button on the top toolbar to initiate the packet capture process.
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5. The packet sniffer software is likely to detect many other packets. To view only the valid data packets,
apply a display filter. 图 15 shows a sample display of what records without a filter applied. The
highlighted row shows an undesired data packet.

图图 15. Packet Sniffer Software, Filterless Recording
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6. To add the appropriate filter checks for only valid packets, select the Display filter tab. In the Field
Name field, select "FCS" from the drop-down options. Click the button labeled First. Modify the filter
condition to only show "OK" packets by typing "FCS=OK" in the Filter condition field, click the Add
button, and then click the Apply filter button. 图 16 shows an example of the filtered view.

图图 16. Packet Sniffer Software, Filtered Recording

7. To export the captured, filtered packets, click the "Save the current session" button on the toolbar
(appears as a floppy disk), or pause the packet capture and click File → Save data… from the file
context menu; either of these choices prompts to save the displayed data as a packet sniffer data
(.psd) file.

8. Convert the .psd file to readable hex values with HexEdit software (http://www.hexedit.com/). A
different hex editor can perform this function as well; however, the authors of this document have not
verified any other options.

9. Open the .psd file in the HexEdit software. Click on Tools → Options. In the HexEdit Options window,
click on Document → Display and change the Columns value to "2066". Click Edit → Select All and
Edit → Copy As Hex Text. Open a text editor program (for example, Notepad), paste the hex text, and
save the text file. This text file can then be imported into Microsoft Excel® spreadsheet software for
further analysis. For more information on the sniffer data packet format, click Help → User Manual on
the packet sniffer software.

http://www.ti.com.cn
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7 Test Setup

7.1 Overview

The Low-Power PIR Motion Detector With Sub-1GHz Wireless Connectivity Enabling 10-Year Coin Cell
Battery Life reference design has been characterized to support all of the critical specifications for this
sub-system. The following sections describe the test setups for these measurements including the
equipment used and the test conditions unless otherwise noted.

7.2 Power Consumption

The power consumption measurements for this reference design were critical in balancing battery lifetime
with sensor bias current and motion sensitivity. An initial prototype was built that allowed measurement of
the different current paths in the design as a preliminary analysis. The results from that prototype are
shown in 8.1 节. Measurements of supply current were then performed on the reference design hardware,
which confirmed the prototype measurements. Further characterization was done on the reference design
hardware over the voltage range of the design. The test setup for the supply current measurements is
illustrated in 图 17.

图图 17. Test Circuit Used for Measuring Supply Current

To compute the battery life, the radio transmission intervals also need to be characterized as these
intervals have brief periods of high peak currents before settling to the low microamp current levels
measured using the setup above. The measurement of the radio transmission interval involves using a
current probe that interfaces to an oscilloscope, which can then be used to trigger on the high current
events. Data from this interval is then exported to Microsoft Excel where analysis of the data can be
performed. This setup is illustrated in 图 18.

图图 18. Test Circuit Used for Measuring Supply Current During Radio Transmission Intervals
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7.3 Functional

The following subsections describe the tests for functionality under various environmental conditions.
These tests generally verify the limits of operation for the subsystem.

7.3.1 Temperature and Humidity Range

This TI Design was stressed under temperature and humidity bias to ensure the design operates and does
not produce false triggers under extremes of the targeted environment. The typical extended building
environment temperature range is assumed to be 0°C to 50°C while additional testing was performed to
test the limits of the design down to –30°C and up to 60°C. Similarly, the typical humidity range for a
building environment is assumed to be 20% to 70%.

The chamber used for the temperature and humidity stress was the CSZ ZH322-H/AC
Temperature/Humidity Chamber and a Vaisala HMP235 Humidity Probe to monitor humidity. A Watlow F-
4 Controller was used to automate the testing. The reference design PCB was placed in the chamber with
a new Energizer CR2032 lithium-ion coin cell battery installed. The CC1111 USB dongle was placed near
the TI Design hardware inside the chamber and connected to a laptop outside of the chamber with a USB
cable to monitor for false triggers during the test. 图 19 shows a picture of the setup.

图图 19. Wireless PIR Motion Detector Temperature and Humidity Test Setup

To prevent false detection due to rapid changes in ambient temperature and subsequent sensor settling,
the temperature was slowly ramped during the test as would be expected in a typical operating
environment. The test was started with a 10-minute soak at 25°C followed by a 1°C per minute ramp up to
50°C with a 5-minute soak, followed by a 5°C per minute ramp to 60°C, and back down to 50°C with a
5-minute soak at 50°C, followed by a 1°C per minute ramp down to 0°C with a 5-minute soak. At 0°C, a
similar 5°C per minute ramp was applied down to –30°C and back up to 0°C with a 5-minute soak at 0°C,
followed by a 1°C per minute ramp back up to 25°C.
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http://www-s.ti.com/sc/techlit/TIDUAU1.pdf


Test Setup www.ti.com.cn

32 ZHCU133B–October 2015–Revised October 2016

TIDUAU1 — http://www-s.ti.com/sc/techlit/TIDUAU1
版权 © 2015–2016, Texas Instruments Incorporated

支持低于 1GHz 无线连接且可使纽扣电池使用寿命长达 10 年的低功耗 PIR 运
动检测器

Because of the physical construction of the chamber and its use of fans for air flow within the chamber,
false triggers were observed during the temperature ramping periods. During the soaking periods, false
triggering subsided over the entire temperature range tested, which proves the functionality of the design
over the temperature extremes. This observation is common for PIR-based motion detectors and for this
reason are generally not recommended for installation near ventilation. The only known way to prevent the
false triggering during this test is to cover the sensor so it could not be affected by thermal gradients due
to forced air flow and reflections off the walls of the chamber; however, this was not done as part of this
measurement.

To prevent false detection due to rapid changes in humidity, the humidity was slowly ramped during the
test as would be expected in a typical operating environment. The test consisted of applying a 1% per
minute ramp from 20% to 70% and then back down to 20% with a 30-minute initial soak. The temperature
was held at 45°C to prevent condensation; however, condensation was observed at 68% and higher
humidity points.

The only anomaly observed during this test was at the point where condensation formed on the PCB,
which produced false triggering. As the humidity dropped to a point where the PCB dried, the false
triggering stopped and was not observed for the remainder of the test.

7.3.2 Motion Sensitivity

The motion sensitivity range was measured by connecting a dual pulse stretcher design built on a generic
prototyping PCB with LED outputs on each channel for visual indication. The inputs to the pulse stretcher
are connected to the window comparator output test points of the reference design. Using this method, the
PIR sensor was allowed to remain stationary at a fixed location while the LED’s indicate when motion is
being detected. The pulse stretcher was powered using its own coin cell battery so that it does not
interfere with or modify the operation of the PIR sensor being tested. The farthest distance at which
reliable detection of motion was indicated was then measured and reported as the motion sensitivity.
Pictures of this setup are shown in 图 20.

http://www.ti.com.cn
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图图 20. Motion Sensitivity Test Setup
(Top: No Motion; Bottom: Motion Detected)

7.3.3 Wireless RF Range

The range of the Wireless Sub-1GHz RF was measured using the CC1111 USB dongle described in 节

6.2.2. For this test, the PIR PCB remained at a stationary location as a laptop with the CC1111 USB
dongle attached and listening was moved away from the PIR PCB. While the CC1111 was on the move,
the PIR design was being reset at regular short intervals to make sure there were radio packets constantly
being transmitted. The distance at which packets were no longer received was then measured.

Different orientations of the PCB and the CC1111 USB dongle with respect to one another were used
during the test. No discernable change in the Wireless RF range was observed.
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7.3.4 RF Immunity

The immunity of this TI Design with respect to radiated RF disturbances was measured according to
IEC61000-4-3 with an extended low frequency range. The IEC standard is specified for a frequency range
of 80 MHz to 1 GHz; however, this testing was extended down to 10 kHz to look for susceptibility in the
design for disturbances closer to the pass band of the circuit.

The setup consisted of connecting the pulse stretcher board used in 节 7.3.2 to the window comparator
outputs and monitoring the LEDs for activity with a camera inside the anechoic chamber. Additionally, a
field strength probe was placed near the board under test for control and monitoring of the RF field
strength level being tested. This test setup is shown in 图 21.

图图 21. RF Immunity Test Setup

The biconical antenna shown in 图 21 was used for the frequency range from 30 MHz to 1 GHz in both
the horizontal and vertical orientation (vertical orientation shown). For frequencies lower than
30 MHz, it was necessary to use a rod antenna in a single orientation.
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8 Test Data

注注: Unless otherwise noted, the test data in the following sections were measured with the
system at room temperature. All of the measurements in this section were measured with
calibrated lab equipment.

8.1 Power Characterization

The supply current for the different circuit paths in this design was measured using an initial prototype
design. This information was used early in the design process to balance the battery lifetime with motion
sensitivity specifications and the sensor bias. This data was also compared to measurements made on the
reference design hardware to make sure there was a good correlation between initial results and final
results. Additionally, the reference design hardware was measured versus supply voltage to look at the
supply current variation with respect to that variable. The supply current data is shown in the following
tables.

表表 2. Low-Power PIR Motion Detector Motion Sensitivity Results

CIRCUIT PATH
SUPPLY CURRENT (IDLE)

NOMINAL MEASURED
Sensor 600 nA 594 nA
Comparators ×2 150 nA 150 nA
Divider 50 nA 50 nA
Opamp1 374 nA 360 nA
Opamp2 409 nA 380 nA
CC1310 100 nA 120 nA
Total 1.683 µA 1.654 µA

表表 3. Low-Power PIR Motion Detector Motion Sensitivity Results

VCC
SUPPLY CURRENT

SHUTDOWN ACTIVE DELTA
3.8 V 1.75 µA 2.46 µA 0.71 µA
3.6 V 1.73 µA 2.45 µA 0.72 µA
3.3 V 1.69 µA 2.36 µA 0.67 µA
3.0 V 1.65 µA 2.30 µA 0.65 µA
2.7 V 1.64 µA 2.28 µA 0.64 µA
2.4 V 1.60 µA 2.22 µA 0.62 µA
2.2 V 1.59 µA N/A N/A

As can be seen, there is a good correlation between the reference design hardware, the initial prototype
measurements, and nominal calculated supply current values. Another observation from 表 3 is that there
is a slight positive dependence of supply current on supply voltage, which is expected. However, this also
suggests that battery life calculations based on average values will be conservative because the supply
current decreases as the battery ages.
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The two modes shown in 表 3 relate to the modes described in 图 9. The Delta column is used to
determine the supply current increase between these two modes as this is the value that will be used in
the battery life calculations. The highlighted row in 表 3 was included for informational purposes only. At
this voltage, the sensor becomes too noisy and starts to generate false triggers. The current in shutdown
mode was only measured by programming the user mode to keep the MCU in shutdown and ignore
interrupts, which is also why there is no data reported for the Active mode at this supply voltage level.

The values to be used in the battery life calculations from 表 3 are the average current over the range of
battery voltages from 3.3 V to 2.4 V. For Shutdown mode, the average current is 1.65 μA while the
average Delta current between Shutdown and Active mode is 0.645 μA.

The final part of the power characterization was to measure the high current interval during radio
transmissions when changing modes. The oscilloscope picture of this event is shown in 图 22 and 图 23.

图图 22. Radio Transmission Event Supply Current (Zoomed in)

图图 23. Radio Transmission Event Supply Current (Full Picture)
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The results for the average current calculation during the radio transmission interval from Excel is 1.12 mA
over a total duration of 104.1 ms.

The data values highlighted in this section are used in the following section to calculate the expected
battery life for different expected use conditions.
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8.2 Battery Life Calculations

The computation of battery life for this reference design is complicated by the myriad of different
applications and use conditions possible for this type of sensor node. The approach taken here computes
the average between two different expected likely use conditions and the worst case use condition. These
use conditions are described as follows:

• Case 1: Worst case: 10 motion events per hour for every hour for the life of the battery. Each of these
motion events is a walk through event meaning that an interrupt is generated by a body moving
through the field of view once, allowing the active timer to expire and re-enter Shutdown mode before
the next event occurs.

• Case 2: Busy room in an office environment case: 14 hours in Shutdown, 10 hours with constant
motion such that the active timer does not expire once activated.

• Case 3: Room with intermittent motion during business hours case: 14 hours in Shutdown, 10 hours
with 10 motion events per hour every hour. Similar to Case 1, each of these events is a walk through
event.

Another available knob in the optimization of battery life for this reference design is the active timer value.
The default value in firmware is 1 minute. Since this value can be modified, the battery life for Case 1 and
Case 3 are recalculated using a value of 30 seconds to show the expected improvement.

The equations for the expected battery life for the three cases in consideration are as follows.

General lifetime equation:

(13)

where

•

space

Case 1
space

space

Case 2
space

space

Case 3
space
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The derating factor in these equations accounts for self aging of the battery. Based on these equations,
the average expected battery lifetime for this reference design with the active timer set to 1 minute is
11.22 years. Re-calculating Case 1 and Case 3 with an active timer set to 30 seconds is 9.9 years and
11.99 years, respectively. The average expected battery life with an active timer value of 30 seconds is
therefore 11.34 years. By inspection, decreasing the active timer to 17 seconds or less will yield a worst
case estimated battery lifetime of at least 10 years.
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8.3 Functional

8.3.1 Motion Sensitivity

The motion sensitivity was measured for multiple sensors with different bias conditions and two different
gain settings. 表 4 summarize these measurement results.

表表 4. Low-Power PIR Motion Detector Motion Sensitivity Results

SENSOR SUPPLY CURRENT
(IDLE) VOUT (DC) MAX. DISTANCE

(Av = 90 dB)
MAX. DISTANCE

(Av = 70 dB)
RS = 2.2 MΩ, RD = 1 MΩ
IRS-B210ST01 365 nA 0.78 V 20 ft 6 ft
IRS-B340ST02 355 nA 0.764 V 25 ft 8 ft
IRA-E700ST0 500 nA 1.093 V 12 ft 4.5 ft
IRA-E712ST3 555 nA 1.204 V 13 ft 5 ft
RS = 1.3 MΩ, RD = 620 KΩ
IRS-B210ST01 594 nA 0.77 V > 30 ft 6.5 ft
IRS-B340ST02 572 nA 0.744 V 27 ft 8 ft
IRA-E700ST0 838 nA 1.085 V 15 ft 5 ft
IRA-E712ST3 920 nA 1.178 V 17 ft 7.5 ft

The highlighted cell in 表 4 illustrates the motion sensitivity of the circuit configuration implemented in this
TI Design.

8.3.2 Wireless RF Range

The wireless RF range was measured to be 220 meters in a typical office environment with partial line of
sight. The measured signal strength at this distance was less than –100 dBm as measured by the CC1111
packet sniffer dongle.

While this distance is outstanding considering the small footprint of the PCB antenna, there are ways to
increase this distance even further. Use of a whip antenna with gain instead of the passive PCB antenna
could offer improvements in the wireless RF range. Another option would be to increase the transmit
power of the CC1310 to its maximum level at the expense of increased supply current during the radio
transmission intervals.
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8.3.3 RF Immunity

The RF immunity of this design was measured to be 30 V/m over the entire 10-kHz to 1-GHz frequency
range. Immunity at field strengths higher than this were not tested due to equipment limitations in the
frequency range around 30 MHz. This level also corresponds to Class 3 in the IEC61000-4-3 standard.

The only anomaly observed during this test was at the singular frequency step of 728.5 MHz, where the
passing immunity level dropped to 29.8 V/m in the horizontal antenna orientation. This drop was due to
the wiring connection between the PIR PCB and the pulse stretcher board used for monitoring.

8.3.4 Vibration

Vibration was not tested on this reference design in any official capacity. Part of the reasoning for this is
that finding vibration specifications on commercially available PIR motion detectors is difficult to find.
Rudimentary vibration testing was performed in the lab by beating on the desk on which the PIR was also
resting and looking for false trigger events at the output of the window comparator. Based on this test, no
false triggers were observed as long as the PCB did not physically move. While crude, this test does show
that there is nothing systematic in the design itself that would cause false triggers in a normal application
aside from the sensor construction itself.

A more informative test would include control over vibration frequency and amplitude with both of these
being varied. The results of such a test would illustrate potential harmonic sensitivities to vibration. PCB
orientation could also be varied as part of this test for a complete picture of the sensitivity to vibration for a
given design in different installations. Because such an elaborate test would yield different results based
on the physical enclosure that would finally house the PCB design, it was determined that this was beyond
the scope of this reference design.

All PIR-based motion sensors are sensitive to vibration in some capacity due to the physical construction
of the sensor as well as the way it naturally operates. Because the PIR sensor is built using thermopiles,
these elements have a crystal structure, which exhibits a piezo-electric effect if the amplitude and
frequency of vibration is such that the thermopiles themselves vibrate. A more prevalent effect is due to
the entire sensor itself moving. Because a Fresnel lens enlarges the effective field of view of the sensor at
substantial distances away from the sensor by focusing IR energy onto the small area of the sensor
elements, any small movement of the sensor will result in large movements in the field of view. Due to
background IR energy, the sensor output will not be able to distinguish between changes in IR energy due
to motion with a static background or the background itself changing rapidly due to movements of the field
of view. In other words, the detection of motion is relative. If the sensor is assumed to be perfectly static,
motion detected will be relative to the sensor, however, motion will also be detected if the background is
static but the sensor is moving. In both cases, the output is valid because there is motion, but the task of
narrowing the output to what is desired falls upon the installation and enclosure design.
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9 Design Files

9.1 Schematics

To download the schematics, see the design files at TIDA-00489.

图图 24. Power and PIR Sensor Schematic
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图图 25. Wireless MCU Schematic
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9.2 Bill of Materials

To download the bill of materials (BOM), see the design files at TIDA-00489.

表表 5. Low-Power PIR Motion Detector With Sub-1GHz Wireless Connectivity Enabling 10-Year Coin Cell Battery Life BOM

ITEM DESIGNATOR QTY VALUE PARTNUMBER MANUFACTURER DESCRIPTION PACKAGE
REFERENCE

1 !PCB1 1 ISE4042 Any Printed Circuit Board

2 A1 1 3.6mVp-p IRS-B210ST01-R1 MuRata Pyroelectric Infrared Sensors for Reflow
Soldering, 3.6mVp-p, SMD 4.7x4.7mm

3 BT1 1 BS-7 Memory Protection Devices Battery Holder, CR2032, Retainer clip, TH CR2032 holder

4 C1, C55 2 100uF C3216X5R1A107M160AC TDK CAP, CERM, 100 µF, 10 V, +/- 20%, X5R,
1206_190 1206_190

5 C2 1 10uF C1608X5R0J106M TDK CAP, CERM, 10 µF, 6.3 V, +/- 20%, X5R,
0603 0603

6 C3 1 10uF GRM155R60J106ME44D MuRata CAP, CERM, 10 µF, 6.3 V, +/- 20%, X5R,
0402 0402

7 C4, C25 2 1uF C1608X7R1C105K TDK CAP, CERM, 1 µF, 16 V, +/- 10%, X7R,
0603 0603

8 C5 1 1uF C1005X5R1A105K050BB TDK CAP, CERM, 1 µF, 10 V, +/- 10%, X5R,
0402 0402

9 C6, C7 2 0.1uF C1005X7R1H104K050BB TDK CAP, CERM, 0.1 µF, 50 V, +/- 10%, X7R,
0402 0402

10 C8, C9, C26 3 0.01uF C1005X7R1C103K TDK CAP, CERM, 0.01 µF, 16 V, +/- 10%,
X7R, 0402 0402

11 C10, C11, C27, C53,
C56, C57 6 1000pF C1005X7R1H102K TDK CAP, CERM, 1000 pF, 50 V, +/- 10%,

X7R, 0402 0402

12 C12, C28 2 100pF C0402C101J3GACTU Kemet CAP, CERM, 100 pF, 25 V, +/- 5%,
C0G/NP0, 0402 0402

13 C13 1 33uF C2012X5R1A336M125AC TDK CAP, CERM, 33 µF, 10 V, +/- 20%, X5R,
0805 0805

14 C14, C16, C18, C19,
C20, C22, C23 7 0.1uF C1005X7R1H104K TDK CAP, CERM, 0.1 µF, 50 V, +/- 10%, X7R,

0402 0402

15 C15 1 0.01uF C1005X7R1E103K TDK CAP, CERM, 0.01 µF, 25 V, +/- 10%,
X7R, 0402 0402

16 C17 1 3.3uF C1005X5R1A335K050BC TDK CAP, CERM, 3.3 µF, 10 V, +/- 10%, X5R,
0402 0402

17 C21 1 1000pF C1005C0G1E102J TDK CAP, CERM, 1000 pF, 25 V, +/- 5%,
C0G/NP0, 0402 0402

18 C24, C30 2 2200pF C1005X7R1H222K TDK CAP, CERM, 2200 pF, 50 V, +/- 10%,
X7R, 0402 0402
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表表 5. Low-Power PIR Motion Detector With Sub-1GHz Wireless Connectivity Enabling 10-Year Coin Cell Battery Life BOM (continued)

ITEM DESIGNATOR QTY VALUE PARTNUMBER MANUFACTURER DESCRIPTION PACKAGE
REFERENCE

19 C31, C33, C34, C35,
C36, C39 6 0.1uF GRM155R70J104KA01D MuRata CAP, CERM, 0.1 µF, 6.3 V, +/- 10%, X7R,

0402 0402

20 C32, C37 2 22uF C1608X5R0J226M080AC TDK CAP, CERM, 22 µF, 6.3 V, +/- 20%, X5R,
0603 0603

21 C40 1 1uF GRM188R70J105KA01D MuRata CAP, CERM, 1 µF, 6.3 V, +/- 10%, X7R,
0603 0603

22 C41, C42 2 12pF GRM1555C1E120JA01D MuRata CAP, CERM, 12 pF, 25 V, +/- 5%,
C0G/NP0, 0402 0402

23 C43, C47 2 3.6pF GRM1555C1H3R6CA01D MuRata CAP, CERM, 3.6 pF, 50 V, +/- 5%,
C0G/NP0, 0402 0402

24 C44, C51 2 100pF GRM1555C1H101JA01D MuRata CAP, CERM, 100 pF, 50 V, +/- 5%,
C0G/NP0, 0402 0402

25 C48 1 2.7pF GRM1555C1H2R7CA01D MuRata CAP, CERM, 2.7 pF, 50 V, +/- 5%,
C0G/NP0, 0402 0402

26 C49 1 6.2pF GRM1555C1H6R2CA01D MuRata CAP, CERM, 6.2 pF, 50 V, +/- 5%,
C0G/NP0, 0402 0402

27 C50 1 3.3pF GRM1555C1H3R3CA01D MuRata CAP, CERM, 3.3 pF, 50 V, +/- 5%,
C0G/NP0, 0402 0402

28 C52 1 0.6pF GJM1555C1HR60BB01D Murata CAP, CERM, 0.6pF, 50V, NP0/C0G, +-
0.1pF, 0402 0402

29 D2, D3 2 75V 1N4148X-TP Micro Commercial
Components Diode, Switching, 75 V, 0.3 A, SOD-523 SOD-523

30 E1 1 ANTENNA_HELICAL N/A PCB Antenna. There is nothing to buy or
mount. Antenna

31 H1, H4, H6, H8 4 NY PMS 440 0025 PH B&F Fastener Supply Machine Screw, Round, #4-40 x 1/4,
Nylon, Philips panhead Screw

32 H2, H3, H5, H7 4 1902C Keystone Standoff, Hex, 0.5"L #4-40 Nylon Standoff
33 H9 1 IML-0669 MuRata Lens, Ceiling Mount, TH D12xH8.508mm

34 J1, J6 2 87898-0204 Molex Header, 2.54 mm, 2x1, Gold, R/A, SMT Header, 2.54 mm,
2x1, R/A, SMT

35 J2 1 GRPB052VWVN-RC Sullins Connector Solutions Header, 50mil, 5x2, Gold, TH Header, 5x2, 50mil
36 J3 1 TSW-102-07-G-S Samtec Header, 100mil, 2x1, Gold, TH 2x1 Header

37 L1 1 1500 ohm BLM18HE152SN1D MuRata Ferrite Bead, 1500 ohm @ 100 MHz, 0.5
A, 0603 0603

38 L2 1 6.8uH MLZ2012N6R8LT000 TDK Inductor, Multilayer, Ferrite, 6.8 µH, 0.11
A, 0.25 ohm, SMD 0805

39 L3, L5 2 7.5nH LQW15AN7N5G00D MuRata Inductor, Wirewound, 7.5 nH, 0.57 A, 0.13
ohm, SMD 1x.5x.5mm
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表表 5. Low-Power PIR Motion Detector With Sub-1GHz Wireless Connectivity Enabling 10-Year Coin Cell Battery Life BOM (continued)

ITEM DESIGNATOR QTY VALUE PARTNUMBER MANUFACTURER DESCRIPTION PACKAGE
REFERENCE

40 L4 1 18nH LQW15AN18NJ00D MuRata Inductor, Wirewound, 18 nH, 0.37 A, 0.27
ohm, SMD 1x.5x.5mm

41 L6, L7 2 6.8nH LQW15AN6N8G00D MuRata Inductor, Wirewound, 6.8 nH, 0.7 A, 0.09
ohm, SMD 1x.5x.5mm

42 L8 1 11nH LQW15AN11NG00D MuRata Inductor, Wirewound, 11 nH, 0.5 A, 0.14
ohm, SMD 1x.5x.5mm

43 Q1 1 -20V SI2323DS Vishay-Siliconix MOSFET, P-CH, -20 V, -3.7 A, SOT-23 SOT-23
44 R1 1 0 CRCW08050000Z0EA Vishay-Dale RES, 0, 5%, 0.125 W, 0805 0805
45 R2 1 619k CRCW0402619KFKED Vishay-Dale RES, 619 k, 1%, 0.063 W, 0402 0402
46 R3 1 6.81k CRCW04026K81FKED Vishay-Dale RES, 6.81 k, 1%, 0.063 W, 0402 0402
47 R4 1 1.30Meg CRCW04021M30FKED Vishay-Dale RES, 1.30 M, 1%, 0.063 W, 0402 0402
48 R5 1 1.50Meg CRCW04021M50FKED Vishay-Dale RES, 1.50 M, 1%, 0.063 W, 0402 0402
49 R6 1 68.1k CRCW040268K1FKED Vishay-Dale RES, 68.1 k, 1%, 0.063 W, 0402 0402

50 R7, R8, R9, R10, R11 5 15Meg RMCF0805JT15M0 Stackpole Electronics Inc RES, 15 M, 5%, 0.125 W, AEC-Q200
Grade 0, 0805 0805

51 R12, R13 2 47.5k CRCW040247K5FKED Vishay-Dale RES, 47.5 k, 1%, 0.063 W, 0402 0402

52 R14, R16, R18, R19,
R20 5 0 CRCW04020000Z0ED Vishay-Dale RES, 0, 5%, 0.063 W, 0402 0402

53 R15 1 100k CRCW0402100KFKED Vishay-Dale RES, 100 k, 1%, 0.063 W, 0402 0402
54 S1, S2 2 B3U-1000P Omron Electronic Components SWITCH TACTILE SPST-NO 0.05A 12V 3x1.6x2.5mm
55 SH-J1, SH-J3, SH-J6 3 1x2 969102-0000-DA 3M Shunt, 100mil, Gold plated, Black Shunt

56 TP1, TP2 2 Black 5001 Keystone Test Point, Miniature, Black, TH Black Miniature
Testpoint

57 TP6, TP7 2 Yellow 5004 Keystone Test Point, Miniature, Yellow, TH Yellow Miniature
Testpoint

58 TP8, TP9, TP13 3 SMT 5015 Keystone Test Point, Miniature, SMT Testpoint_Keystone_
Miniature

59 U2A, U2B 2 LPV802DGKR Texas Instruments 350 nA Rail-to-Rail I/O Nanopower
Operational Amplifier Family, DGK0008A DCK0005A

60 U3, U4 2 TLV3691IDCK Texas Instruments 0.9-V to 6.5-V, Nanopower Comparator,
DCK0005A DCK0005A

61 U5, U6, U7, U8 4 TPD1E10B06DPYR Texas Instruments

ESD in 0402 Package with 10 pF
Capacitance and 6 V Breakdown, 1
Channel, -40 to +125 degC, 2-pin X2SON
(DPY), Green (RoHS & no Sb/Br)

DPY0002A

62 U9 1 CC1310F128RGZR Texas Instruments Sub-1 GHz and 2.4 GHz Multi-standard
RF IC Family, RGZ0048A RGZ0048A
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表表 5. Low-Power PIR Motion Detector With Sub-1GHz Wireless Connectivity Enabling 10-Year Coin Cell Battery Life BOM (continued)

ITEM DESIGNATOR QTY VALUE PARTNUMBER MANUFACTURER DESCRIPTION PACKAGE
REFERENCE

63 Y1 1 FC-12M 32.7680KA-A3 Epson Crystal, 32.768kHz, 12.5pF, SMD Crystal
2.05x.6x1.2mm

64 Y2 1 TSX-3225 24.0000MF20G-
AC3 Epson Crystal, 24 MHz, 9 pF, SMD

SMD, 4-Leads, Body
2.65x3.35mm,
Height 0.6mm

65 C29 0 22uF C1608X5R0J226M080AC TDK CAP, CERM, 22 µF, 6.3 V, +/- 20%, X5R,
0603 0603

66 C38 0 0.1uF GRM155R70J104KA01D MuRata CAP, CERM, 0.1 µF, 6.3 V, +/- 10%, X7R,
0402 0402

67 C45, C46 0 12pF GRM1555C1E120JA01D MuRata CAP, CERM, 12 pF, 25 V, +/- 5%,
C0G/NP0, 0402 0402

68 C54 0 1pF GRM1555C1H1R0CA01D MuRata CAP, CERM, 1 pF, 50 V, +/- 5%,
C0G/NP0, 0402 0402

69 FID1, FID2, FID3,
FID4, FID5, FID6 0 N/A N/A Fiducial mark. There is nothing to buy or

mount. N/A

70 J4 0 TSW-106-07-G-S Samtec Header, 100mil, 6x1, Gold, TH 6x1 Header
71 J5 0 CONSMA001-SMD-G Linx Technologies Jack, SMA, PCB, Gold, SMT SMA Jack
72 R17 0 0 CRCW04020000Z0ED Vishay-Dale RES, 0, 5%, 0.063 W, 0402 0402
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9.3 PCB Layout Recommendations

To ensure high performance, the Low-Power PIR Motion Detector With Sub-1GHz Wireless Connectivity
Enabling 10-Year Coin Cell Battery Life TI Design was laid out using a four-layer PCB. The second layer
is a solid GND pour, and the third layer is used for power rail routing with GND fills in unused areas. The
top and bottom layers are used for general signal routing and also have GND fills in unused areas. For all
of the TI products used in this TI Design, adhere to the layout guidelines detailed in their respective
datasheets.

Additionally, because of the low-power design and the resulting high-impedance paths present in the
design, keep the signal routes in the analog sensor path between the PIR sensor output and the window
comparator input as short as possible with adequate GND fill around these signals.

If this design is to be used in an environment where dust or moisture accumulation is possible, be aware
that it may be necessary to include a conformal coating to eliminate additional leakage paths due to the
operating environment over time.

The antenna on this TI Design is the miniature helical PCB antenna for 868 MHz or 915 MHz. See the
application note DN038 (SWRA416) for more details about layout and performance.

9.3.1 Layout Prints

To download the layout prints, see the design files at TIDA-00489.

图图 26. Top Silkscreen 图图 27. Top Solder Mask

图图 28. Top Layer 图图 29. GND Layer
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图图 30. Power Layer 图图 31. Bottom Layer

图图 32. Bottom Solder Mask 图图 33. Bottom Silkscreen

图图 34. Board Dimensions

9.4 Altium Project

To download the Altium project files, see the design files at TIDA-00489.
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75.00mm

35
.0

0m
m

Solid ground plane on Layer 2
Power routed on Layer 3

Via stitching to ensure a low
impedance path is available for
RF noise

No copper pour around the
antenna section

For the integrated DC-DC converter in the
CC1310, the input capacitors C37 and
C39, inductor L2, and output capacitor C32
are placed such that the current loop area
formed by these components is minimized.
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9.5 Layout Guidelines

图图 35. Low-Power PIR Motion Detector Reference Design Layout Guidelines
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9.6 Gerber Files

To download the Gerber files, see the design files at TIDA-00489.

图图 36. Fabrication Drawing
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9.7 Assembly Drawings

To download the assembly drawings, see the design files at TIDA-00489.

图图 37. Top Assembly Drawing

图图 38. Bottom Assembly Drawing
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10 Software Files

To download the software files, see the design files at TIDA-00489.
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